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In this section:

■■ Understanding formulas and cell 
references in Excel

■■ Creating and editing formulas

■■ Creating, editing, and deleting named 
ranges

■■ Using named ranges in formulas

■■ Summarizing the values in groups of 
cells

■■ Creating formulas that reference cells 
in other workbooks

■■ Analyzing data using the Quick Analysis 
Lens

■■ Summing with subtotals and grand 
totals

■■ Exploring the Excel function library

■■ Creating conditional functions

■■ Exploring new functions in Excel 2013

Using formulas and 
functions 6
Microsoft Excel 2013 workbooks let you do much more than simply 

store and organize your data. One important task that you can per-
form in Excel is to summarize the values in related cells. Whether those 
cells represent the sales for a day at your store, the returns from your 
personal investments, or your times in bicycle races, you can find the total 
or average of the values, identify the minimum or maximum value in a 
group, or perform dozens of other calculations on your data. Many times 
you can’t access the information that you want without referencing more 
than one cell; it’s also often true that you’ll use the data in the same group 
of cells in more than one calculation. Excel makes it easy to reference a 
number of cells at once, letting you build your calculations quickly.



Build a formula
1	 Click the cell in which you want to enter a formula.

2	 Type =.

3	 Type the expression representing the calculation that you want to 
perform. 

4	 Press Enter.

Creating simple cell formulas 
Building calculations in Excel is pretty straightforward. If you 
want to find the sum of the values in two cells, you just type an 
equal sign (=), the reference of the first cell, a plus sign (+), and 

the reference of the second cell. The formula that you enter 
appears on the formula bar, where you can examine and edit it.

1

2

3

Edit a formula
1	 Click the cell that you want to edit.

2	 Select the part of the formula that you want to edit in the formula 
bar.

3	 Make any changes that you want.

4	 Press Enter.

TRY THIS  Click the Excel Help button. Then, in the Excel Help 
dialog box, type common formulas in the Search box, press 

Enter, and click Examples Of Commonly Used Formulas in the list of 
available topics. The Help file that appears has quite a few examples of 
formulas that you might want to create.

CAUTION  Be sure that there’s no space before the equal sign 
in your formula. If there is, Excel interprets the cell’s contents as 

text, not as a formula.
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Understanding formulas and cell references in Excel
When you build a formula, you need to identify the work-
sheet cells that provide the values for the formula and the 
operations that you want to perform on those values. To 
identify a cell, you give its cell a reference. The first cell in the 
first column is cell A1, meaning column A, row 1. If you exam-
ine a formula, you sometimes see a cell reference written as 
$A$1, rather than just A1. The difference is that cell references 
written with the dollar signs are absolute references, meaning 
that the reference doesn’t change when the formula is copied 
to another cell. Cell references written without the dollar signs 
are relative references, which do change when the formula 
with the reference is copied to another cell.

The benefit of relative references is that you can write a for-
mula once, copy it to as many other cells as you like, and have 
Excel update the formulas to reflect the new cells. For exam-
ple, consider the worksheet in the following figure, which 
tracks the number of hourly package pickups for a month.

The cells in column P contain formulas that calculate the sum 
of the hourly pickup values in column C through column 
O. The formula in cell P5, =SUM(C5:O5), finds the sum of 
cells in row 5, corresponding to January 1. When you copy 
the formula from cell P5 to cell P6, the formula changes to 
=SUM(C6:O6). Excel notices that you copied the formula to a 
new row and assumes that you want the formula to work on 
that data. Had you written the formula as =SUM($C$5:$O$5), 
however, Excel would notice that the formula used absolute 
references and would copy the formula as =SUM($C$5:$O$5).

If you want to reference a value from a cell in another work-
book, you can do that. Excel uses 3D references, which means 

that any cell in any workbook can be described by three 
pieces of information: the name of the workbook, the name 
of the worksheet, and the cell reference.

Here’s the reference for cell Q38 on the January worksheet in 
the Y2013ByMonth workbook:

[Y2013ByMonth.xlsx]January!$Q$38

The good news is that you don’t need to remember how 
to create these references yourself. If you want to use a cell 
from another workbook in a formula, all that you need to 
do is click the cell where you want to use the value, start the 
formula, and then click the cell in the other workbook. Excel 
fills in the reference for you.
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Go to a named range
1	 Click the Name Box down arrow.

2	 Click the range to which you want to go.

Create a named range
1	 Select the cells that you want to name.

2	 Click the Name Box on the formula bar.

3	 Type the name that you want for the range.

4	 Press Enter.

Assigning names to groups of cells 
When you work with large amounts of data, it’s easy to lose 
track of which cells contain which data. In addition, it can be 
difficult to locate data in workbooks that you didn’t create. 
Although you might always store product prices in one work-
sheet column, there’s no guarantee that your colleagues will 
follow the same pattern! One way to prevent confusion is to 

define a named range for any cell group that holds specific 
information. For example, in a worksheet with customer order 
data, you can define the Totals named range to represent the 
cells in which the total for each order is stored. After you define 
the named range, you can display its contents, rename it, or 
delete it.

2

1

3

1

2

SEE ALSO  For information about selecting cells from several 
parts of the same worksheet, see “Select a noncontiguous group 

of cells” on page 40.
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Delete a named range
1	 Click the Formulas tab.

2	 Click Name Manager.

3	 Click the named range that you want to delete.

4	 Click Delete.

5	 Click OK to clear the confirmation dialog box that appears.

6	 Click Close.

Rename a named range
1	 Click the Formulas tab.

2	 Click Name Manager.

3	 Click the named range that you want to rename.

4	 Click Edit.

5	 Type a new name for the range.

6	 Click OK.

7	 Close the Name Manager dialog box.

3 4

1 2 7

CAUTION  The name that you give your named range 
shouldn’t duplicate a potential cell address. For example, typing 

DAY1 in a formula would reference cell DAY1. To avoid this problem, 
either ensure that your ranges have names that begin with at least four 
letters (the last column is XFD) or use an underscore to separate the 
letters from the rest of the name. The name DAY1 isn’t valid, but the 
name DAY_1 is. 65
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Create a formula with a named range
1	 Click the cell in which you want to enter a formula.

2	 Type = followed by the formula that you want. When you want to 
use a range that has a name, start typing the name instead of the 
cell address.

3	 Click the named range in the Formula AutoComplete list that 
appears.

4	 Press Enter.

Using names in formulas 
When you define a named range, you create a shortcut that you 
can use to refer to a group of cells. A great way to use named 
ranges is in formulas. Instead of entering the references of 
every cell that you want to use in your calculation, you can type 
the name of the range. When you reference named ranges in 
formulas, your formulas are shorter and easier to understand. 
Rather than seeing a series of cell references that you need to 
examine, you and your colleagues can rely on the named ranges 
to understand the goal of a calculation.

Excel 2013 further streamlines formula creation with Formula 
AutoComplete. Remember that when you start typing a value 
into a cell, Excel examines the previous values in that column 
and offers to let you complete the entry by pressing Tab or 
Enter. Now, when you start typing a named range’s name into a 
formula, Excel recognizes that you might be entering a named 
range and displays a list of named ranges (as well as built-in 
functions) available in the active workbook. All you have to do 
is click the named range that you want, and it’s included in the 
formula immediately.

TIP  If you change the name of a range of cells, Excel automati-
cally makes the name change in every one of your formulas.

2 1

3
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Create a formula with an Excel table reference
1	 Click the cell in which you want to create the formula.

2	 Type =, followed by the function to include in the formula and a left 
parenthesis; for example, =SUM( would be a valid way to start.

3	 Type the name of the Excel table.

4	 Type a left square bracket.

5	 Click the name of the table column.

6	 Type a right square bracket, a right parenthesis, and press Enter.

Creating a formula that references values in an Excel table
In previous versions of Excel, it was a challenge to create named 
ranges that included an entire column in a data list. Suppose 
that you created a named range that encompassed the exist-
ing cells in a data column, such as the cell range A3:A44; if you 
added data to cell A45, you would need to change the cells in 
the named range’s definition. Yes, there is a complicated way to 

create a dynamic named range in Excel 2003 and earlier ver-
sions, but you don’t have to worry about it in Excel 2013. All 
you need to do is create an Excel table (as shown in “Creating 
an Excel table” on page 52) and select the headers of the col-
umns that contain the data that you want to summarize in your 
formulas.

TIP  To include more than one table column in a formula, 
either hold down the Shift key, select the column header of the 

first column to use in the formula, and then click another column to 
select everything in the span between the two columns, or hold down 
the Ctrl key and click the other column headers that you want to use. 
Excel includes the references in the formula.

31
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Use cells from other workbooks in a formula
1	 Open the workbook with the cell that you want to reference in your 

formula.

2	 Display the workbook where you want to create the formula.

3	 In the workbook cell where you want to create the formula, type = 
followed by the first part of the formula.

4	 Click the View tab.

5	 Click Switch Windows.

6	 Click the name of the workbook with the cell that you want to 
include in the formula.

7	 Select the cells with the values that you want to use in the formula.

8	 Press Enter.

Creating formulas that reference cells in other workbooks
One of the strengths of Excel is that you aren’t limited to using 
cells from the current workbook in your formulas. If you want, 
you can use data from any other workbook in your calculations. 
For example, you might have a workbook in which you track 
monthly advertising sales for your newsletter. If you want to 
create a new workbook to summarize all income and expenses 
for your publication, you can do so. By letting you create for-
mulas that reference cells from more than one workbook, Excel 
makes it easy for you to organize your workbooks so that each 

workbook holds data about a specific subject. Not only can you 
find the data easily, you can reference it anywhere else.

After you create links between workbooks, you can have Excel 
update your calculation if the data in the linked cell changes. 
You can also change the cell to which you linked, or if the 
workbook with the cell to which you linked has been moved or 
deleted, you can delete the link and have Excel store the last 
value from the calculation.

4 5
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Break links to other workbooks and convert 
to values
1	 Click the cell that contains the formula that you want to edit.

2	 Select the part of the formula representing the link that you want to 
break.

3	 Press F9.

4	 Press Enter.

TIP  You can use the techniques here to link to a cell on a 
different worksheet in the same workbook. Just create the 

formula, and when you want to put in the cell reference, move to the 
target worksheet and click the appropriate cell.

1

2

2

1Refresh links
1	 Click the Data tab.

2	 In the Connections group, click Refresh All.
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TIP  Under certain circumstances, such as when the new target 
workbook contains a single worksheet, the option to select a 

sheet might not appear. 

Change links to different workbooks
1	 Click the Data tab.

2	 In the Connections group, click Edit Links.

3	 Click the link that you want to change.

4	 Click Change Source.

5	 Click the workbook with the new cell to which you want to link.

6	 Click Open.

7	 Select the sheet from which to update values.

8	 Click OK.

9	 Click Close.

2 1 3
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Changing links to different workbooks
If you create a link to a value in another workbook, you might 
find that the other workbook’s structure changes. You can 
update the properties of a link by using the Edit Links dialog 

box, which you can open using the controls on the Data tab of 
the ribbon.

6
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Summarize data by using Quick Analysis
1	 Select the cell range that you want to summarize.

2	 Click the Quick Analysis action button to display the Quick Analysis 
tools available to you.

3	 Click the label representing the category of tools that you want to 
use.

4	 Click the button representing the summary that you want to create.

Analyzing data by using the Quick Analysis lens
One of the refinements in Excel 2013 is the Quick Analysis lens, 
which brings the most commonly used formatting, charting, and 
summary tools into one convenient location. You have a wide 
range of tools available to you, including the ability to create 
an Excel table or PivotTable, insert a chart, or add conditional 

formatting. You can also add total columns and rows to your 
data range. For example, you can click Totals and then Running 
Total for columns, identified by the icon labeled Running Total 
and the yellow column at the right edge of the button, to add a 
column that calculates the running total for each row.

TIP  You can add one summary column and one summary row 
to each data range. If you select a new summary column or row 

when one exists, Excel displays a confirmation dialog box to verify that 
you want to replace the existing summary. When you click Yes, Excel 
makes the change.

SEE ALSO  For information about creating a chart by using the 
Quick Analysis lens, see Section 12, “Summarizing data visually 

using charts.”
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Summarize data in a group of cells
1	 Select the cells that you want to summarize to have the summary 

appear on the status bar.

Summing a group of cells without using a formula
Sometimes, such as when you’re entering data into a worksheet 
or you’re curious to find out the sum or average of the values 
in a few cells, it’s too much work to find a blank cell and write 
a formula to calculate the sum or average for the cells. Rather 
than make you create a separate formula, Excel counts the 
number of cells selected, calculates a running total and average 

for the currently selected cells, and displays the results on the 
status bar. Finding the sum, average, and count of the values 
in the selected cells are the most commonly used operations, 
so Excel calculates those values by default. However, you can 
choose from several other operations, or you can even tell Excel 
not to calculate a running total for any selected cells.

TIP  Active summary operations are checked on the shortcut 
menu. Clicking a checked summary operation turns off that 

operation.

Find the total, average, or other values of cell 
data
1	 Right-click the status bar, and choose the summary operations that 

you want from the shortcut menu.

1
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Creating a summary formula
After you enter data into a worksheet, you can create formu-
las to summarize the values and display the result of the cal-
culation. You can summarize the values in a group of cells in 
many ways: You can find the total or average of the cell values, 
identify the maximum or minimum value in the group, or simply 
count the number of cells containing values. You can create 
these formulas by clicking the cell below or to the right of the 

cells that you want to summarize, displaying either the Home 
tab or the Formulas tab, and clicking the AutoSum button. (The 
button appears on both tabs.) Clicking the AutoSum button 
creates a SUM formula, which finds the arithmetic sum of the 
values, but you can choose other calculations by clicking the 
AutoSum button’s down arrow. After you create the formula 
that you want, you can use the result in other calculations.

Create an AutoSum formula
1	 Click the cell where you want the summary value to appear.

2	 Click the Home tab.

3	 Click the AutoSum down arrow.

4	 Click the AutoSum function that you want to use.

5	 If necessary, select the cells with the data that you want to 
summarize.

6	 Press Enter.

SEE ALSO  For information about finding a running total for a 
group of cells without creating a formula, see “Summing a 

group of cells without using a formula” on the previous page.
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Create a subtotal
1	 Click any cell in the range that you want to subtotal.

2	 Click the Data tab.

3	 In the Outline group, click Subtotal.

4	 Click the At Each Change In down arrow.

5	 Click the value on which you want to base the subtotals.

6	 Click the Use Function down arrow.

7	 Click the subtotal function that you want to use.

8	 Select which columns should have subtotals calculated.

9	 Click OK.

Summing with subtotals and grand totals 
You frequently need to organize the data in an Excel worksheet 
by one or more criteria. For example, you might have a work-
sheet in which you list yearly sales for each product that you 
offer, with the products broken down by category. If your data 
is organized this way, you can have Excel calculate a subtotal 

for each category of products. When you create a subtotal, you 
identify the cells with the values to be calculated and the cells 
that identify the change from one category to the next. Excel 
updates the subtotal and grand total for you if the value of any 
cell changes.
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Remove a subtotal
1	 Click any cell in the subtotaled range.

2	 Click the Data tab.

3	 Click Subtotal.

4	 Click Remove All.

4
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List functions available from the Excel library
1	 Click the Insert Function button on the formula bar.

2	 Display the drop-down list, and click the function category that you 
want to view.

3	 Click the function that you want to examine.

4	 Click OK.

5	 Click Cancel to close the Function Arguments dialog box.

Exploring the Excel function library
You can create dozens of different functions in Excel. You can 
use Excel functions to determine mortgage payments, perform 
scientific calculations, or find the square root of a number. The 
best way to become familiar with the formulas available in Excel 
is to display the Insert Function dialog box and move through 
the listed functions, clicking the ones that look interesting. 
When you click a function, its description appears at the bottom 
of the dialog box.

Another way to get information about a function is to view the 
ScreenTip that appears next to the function. If you double-click 
a cell with a function, a ScreenTip with the function’s structure 
and expected values appears below it. Clicking an element of 
the structure points to the cell or cells providing that value.
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Use function ScreenTips
1	 Double-click a cell that contains a formula.

2	 In the ScreenTip, click the function name to open the Help file entry 
for the function.

3	 Click the Close button to close the Help window.

4	 Click an argument to select the cells to which it refers.

421
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Create an IF function
1	 Click the cell in which you want to enter an IF function.

2	 Click the Formulas tab.

3	 Click Logical.

4	 Click IF.

5	 Type a conditional statement that evaluates to true or false.

6	 Type the text that you want to appear if the condition is true.

7	 Type the text that you want to appear if the condition is false.

8	 Click OK.

Using the IF function
In addition to calculating values based on the contents of 
other cells, you can have Excel take different actions based on 
the contents of those other cells by using the IF function. For 
example, if you create a workbook to track the times of riders 
in a bicycle racing club, you can create a formula to compare 

each rider’s time to their previous times. When someone’s most 
recent time is the lowest time in the group, you can have Excel 
display Personal Best in the cell with the formula, alerting you to 
congratulate the rider in your next club newsletter.

CAUTION  The text message must be enclosed in quotation 
marks.

TIP  You can also create an expression in the Value_If_True and 
Value_If_False boxes. Excel displays the result of the expression 

in the appropriate box.
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Find cell precedents and dependents
1	 Click the cell that you want to examine.

2	 Click the Formulas tab.

3	 Using the controls in the Formula Auditing group, follow either of 
these steps:

a	 Click Trace Precedents.

b	 Click Trace Dependents.

Checking formula references
When you create a formula that draws values from several dif-
ferent places in your workbook—or from other workbooks—it 
can be difficult to see what’s going wrong if your formula isn’t 
producing the expected results. Excel helps you locate a cell’s 
precedents (the cells that the formula uses in its calculation) and 

dependents (the cells that depend on the current cell to calcu-
late their own values). To help you find what you need to check 
your formulas, Excel groups all the tools that you need on the 
Formula Auditing group on the Formulas tab.

TIP  Tracer arrows are particularly effective when they’re used 
to examine formulas that include named ranges. When you 

refer to a named range, you know what the indicated cells are sup-
posed to represent.

Remove tracer arrows
1	 Click the Formulas tab.

2	 Click the Remove Arrows down arrow, and follow any of these steps:

a	 Click Remove Arrows to remove all arrows.

b	 Click Remove Precedent Arrows to remove the precedent arrows.

c	 Click Remove Dependent Arrows to remove the dependent 
arrows.

2

1

3

1

2

Checking formula references: Remove tracer arrows  115

6: Using formulas and functions



Monitor a formula for changes
1	 Click the Formulas tab.

2	 Click Watch Window.

3	 Click Add Watch.

4	 Select the cells that you want to watch.

5	 Click Add.

6	 Click Watch Window.

Debugging your formulas
When you share a workbook with your colleagues, some of 
the values in that workbook might change rapidly as new data 
is entered. For example, workbook data probably will change 
quickly if you are evaluating stock prices. Stock market values 
change frequently, so your data will as well. You can monitor 
the value in a cell even while you’re using another workbook by 
setting a watch. When you set a watch, the values of the cells 
you’re monitoring appear in the Watch Window.

Another way that you can monitor your data is to check the 
result of part of a calculation by using the Evaluate Formula 
dialog box. When you click the Evaluate Formula button, Excel 
displays the formula in the active cell and the subtotal for part 
of the calculation. You can move through the formula bit by bit, 
with Excel showing you the result of each piece of the formula.
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Delete a watch
1	 Click the Formulas tab.

2	 Click Watch Window.

3	 Click the watch that you want to delete.

4	 Click Delete Watch.

5	 Click the Close button.

Evaluate parts of a formula
1	 Click the cell with the formula that you want to evaluate.

2	 Click the Formulas tab.

3	 Click Evaluate Formula.

4	 Click Evaluate (one or more times) to move through the formula’s 
elements.

5	 Click Close.
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Table 6-1  New functions in Excel 2013

Category Function Name Description

Date and Time DAYS Calculates the number of days between two dates.

Date and Time ISOWEEKNUM Returns the number of the ISO week number of the year for a given date.

Engineering BITAND Returns a bitwise AND of two numbers.

Engineering BITLSHIFT Returns a numbered generated by shifting the bits in a number to the left by a speci-
fied number of places.

Engineering BITOR Returns a bitwise OR of two numbers.

Engineering BITRSHIFT Returns a number generated by shifting the bits in a number to the right by a speci-
fied number of places.

Engineering BITXOR Returns a bitwise XOR of two numbers.

Engineering IMCOSH Returns the hyperbolic cosine of a complex number.

Engineering IMCOT Returns the cotangent of a complex number.

Engineering IMCSC Returns the cosecant of a complex number.

Engineering IMCSCH Returns the hyperbolic cosecant of a complex number.

Engineering IMSEC Returns the secant of a complex number.

Engineering IMSECH Returns the hyperbolic secant of a complex number.

Engineering IMSINH Returns the hyperbolic sine of a complex number.

Engineering IMTAN Returns the tangent of a complex number.

New functions in Excel 2013
Excel 2013 includes 51 new functions that you can use for 
dates, statistics, engineering, and even web data. 

Table 6-1 lists all of the functions and describes what they do.
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Category Function Name Description

Financial PDURATION Calculates the number of periods that an investment will take to reach a value.

Financial RRI Calculates the equivalent interest rate for the growth of an investment.

Information ISFORMULA Returns TRUE if a cell contains a formula.

Information SHEET Returns the sheet number of a sheet.

Information SHEETS Returns the number of sheets in a reference.

Logical IFNA Returns a value that you specify if an expression results in an #N/A error; otherwise, it 
returns the value of the expression.

Logical XOR Returns the logical exclusive OR of all arguments (that is, it returns TRUE if exactly one 
argument is true).

Lookup and Reference FORMULATEXT Returns the formula in the referenced cell as text.

Math and Trigonometry ACOT Returns the arccotangent of a number.

Math and Trigonometry ACOTH Returns the hyperbolic arccotangent of a number.

Math and Trigonometry ARABIC Converts a number written as a Roman numeral into an Arabic number.

Math and Trigonometry BASE Converts a number into a text representation of the number in a given base.

Math and Trigonometry CEILING.MATH Rounds a number up to the nearest integer or to the nearest significant multiple.

Math and Trigonometry COT Returns the hyperbolic cosine of a number.

Math and Trigonometry COTH Returns the cotangent of an angle.

Math and Trigonometry CSC Returns the cosecant of an angle.

Math and Trigonometry CSCH Returns the hyperbolic cosecant of an angle.

Math and Trigonometry DECIMAL Converts a text representation of a number in a given base to a decimal number.

Math and Trigonometry FLOOR.MATH Rounds a number down to the nearest integer or to the nearest significant multiple.

6: Using formulas and functions

New functions in Excel 2013  119



Category Function Name Description

Math and Trigonometry ISO.CEILING Returns a number that is rounded up to the nearest integer or to the nearest signifi-
cant multiple.

Math and Trigonometry MUNIT Returns the unit matrix of the specified dimension.

Math and Trigonometry SEC Returns the secant of an angle.

Math and Trigonometry SECH Returns the hyperbolic secant of an angle.

Statistical BINOM.DIST.RANGE Calculates the probability of a result using the binomial distribution.

Statistical COMBINA Returns the number of combinations for a given number of items, allowing 
replacement.

Statistical GAMMA Returns the Gamma function value.

Statistical GAUSS Returns 0.5 less than the standard normal cumulative distribution.

Statistical PERMUTATIONA Returns the number of permutations for a given number of items, allowing 
replacement.

Statistical PHI Returns the value of the density function for a standard normal distribution.

Statistical SKEW.P Returns the skewness of a distribution based on the population instead of a sample 
from the population.

Text NUMBERVALUE Converts text to a number.

Text UNICHAR Returns the Unicode character referenced by a number.

Text UNICODE Returns the Unicode number of the first character of a text string.

Web ENCODEURL Returns a URL-encoded string.

Web FILTERXML Returns specific data from XML content using a user-supplied xpath value.

Web WEBSERVICE Returns data from a web service.
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Symbols
3-D pie charts,  259
3D references,  99
3-D Rotation button,  277

A
accepting changes, group 

environments,  316–317
Access, exchanging data with Excel,  306–307
Accounting number style,  126
ACOT function,  119
ACOTH function,  119
active filters,  225
adding

chart titles,  247
clip art to worksheets,  286–287
commands to Quick Access 

toolbar,  198–199
comments, group environments,  313
data labels to charts,  248
data series,  254
equations to shapes,  294–295
Excel 2013 to Start screen,  22
hyperlinks to files,  58–59
hyperlinks to webpages,  60
mailto hyperlinks,  61
object shadows,  276
pictures to worksheets,  270–271
ribbon elements,  202–203
slicers,  228
trendlines to charts,  261
WordArt text,  284

advanced filters,  226–227
advanced paste options,  64–65
aligning

cell contents,  136–137
drawing objects,  282–283

Align Left button,  136
Align Right button,  136
Allow Changes By More Than One User check 

box,  312
analysis of data, PowerPivot,  223
analyzing data

creating summary formulas,  109
groups of cells,  108
Quick Analysis lens,  107
Quick Analysis Lens,  9
subtotals and grand totals,  110–111

appearance, charts,  244–245
applying, shape styles,  273
ARABIC function,  119
ascending order (sorting data),  216
assigning named ranges to cells,  100–101
AutoComplete,  50
AutoCorrect

defining entries,  212–213
dialog box,  214

AutoFill,  46–47
AutoFilter,  220–221
AutoFormat, controlling rules,  214
AutoRepublish Every Time This Workbook Is 

Saved check box,  323
AutoSum formulas,  109
axes (charts), formatting,  250–251

B
background

formatting cells,  128–129
removing from images,  280–281

Backstage view,  174
BASE function,  119
Beautiful Evidence,  262
Bing maps,  235
BINOM.DIST.RANGE function,  120
BITAND function,  118
BITLSHIFT function,  118
BITOR function,  118
BITRSHIFT function,  118
BITXOR function,  118
Blank Workbook button,  28
borders, formatting cells,  130–131
Bottom Align button,  136
building formulas,  98

C
CEILING.MATH function,  119
cell references,  18
cells

clearing contents,  66–67
creating formulas,  98–99

AutoSum formulas,  109
named ranges,  100–102
precedents and dependents,  115
referencing other workbooks,  104–106
referencing tables,  103
subtotals and grand totals,  110–111

Index
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clip art,  286–287
Clip Art task pane,  286
closing workbooks,  35
Collapse Formula Bar control,  42
coloring sheet tabs (formatting 

worksheets),  157
color scales, formatting cells,  146
Colors dialog box,  81
columns

clearing filters,  224
deleting,  86
Excel tables,  55
formatting worksheets

changing width,  160
deleting,  166
hiding,  168–170
inserting,  162
moving,  164–165
resizing,  161

headings, printing worksheets,  181
hiding/unhiding,  88–89
inserting,  84
moving,  87
selection,  41

column sparklines,  262
COMBINA function,  120
combining data, Flash Fill,  48
commands

Quick Access toolbar,  198–199
suggestions from shortcut menus,  36

Comma Style button,  126
comments

group environments
adding/viewing,  313
editing/deleting,  314

condition formats
changing how rules are applied,  142–143
deleting,  147
editing,  140–141
formatting,  138–143

changes (group environments)
accepting/rejecting,  316–317
maintaining change history,  318–319
tracking,  315

changing
chart source data,  252
default file folder,  34
diagrams,  288–289
links to workbooks,  106
worksheet tab colors,  81

Chart Data Range field,  252
Chart Elements button,  246
Chart Filters button,  256
charts,  240–241

appearance,  244–245
copying data into PowerPoint,  304–305
data labels and grid lines,  248–249
data series,  254–255
filtering,  256–257
formatting,  16
formatting chart axes,  250–251
layout and style,  242–243
legends and titles,  246–247
organization charts,  290–291, 292–293
pie charts,  258–259
Recommended Charts gallery,  11
source data,  252
sparklines,  262–265
stock charts,  260
trendlines,  261

Chart Styles button,  16, 243
Chart Styles gallery,  16, 243
Clear Filter button,  230
clearing

cell contents,  66–67
filters,  224–225
Office Clipboard items,  69
slicers,  230

Clear Selected Sparklines button,  265

data entry
AutoFill,  46–47
creating Excel tables,  52–54
cutting, copying, and pasting cell 

values,  62, 64–65
dates and times,  44–45
editing cell contents,  56
finding/replacing text,  70–71
Flash Fill,  48–49
inserting symbols in cells,  57
numbers,  43
Office Clipboard,  68–69
shortcuts,  50–51
spelling checker,  72
text,  42

defined,  18
deleting,  83
formatting

backgrounds and shading,  128–129
borders,  130–131
color scales,  146
condition formats,  138–143
contents,  122–124, 136–137
data bars/icon sets,  144
dates,  125
defining cell style,  132–133
Format Painter,  150
merging/splitting cells,  148–149
modifying/deleting cell style,  134–135
numbers,  126–127

hyperlinks,  58–61
inserting,  82
locking,  172
moving,  83
named ranges,  100–101
selection,  40–41

Center button,  136
Change Chart Type button,  244
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PowerPivot analysis,  223
PowerView,  235
recommended PivotTables,  236–237
sharing

Excel and Access,  306–307
Excel and PowerPoint,  304–305
Excel and Word,  302–303
group environments,  312–337
importing text files,  308–309
linking and embedding,  298–301

sorting,  216–219
summarizing charts,  240–265

data analysis
creating summary formulas,  109
Quick Analysis lens,  107
Quick Analysis Lens,  9
subtotals and grand totals,  110–111
summarizing data in a group of cells,  108

data bars, displaying,  144
data entry

cell selection,  40–41
clearing cell contents,  66–67
creating Excel tables,  52–54
cutting, copying, and pasting cell 

values,  62, 64–65
dates and times,  44–45
editing cell contents,  56
Excel interpretation,  51
fills

AutoFill,  46–47
Flash Fill,  48–49

finding/replacing text,  70–71
Flash Fill,  10
galleries,  19
inserting symbols in cells,  57
numbers,  43
Office Clipboard,  68–69
shortcuts,  50–51
spelling checker,  72

CSC function,  119
CSCH function,  119
current date/time,  45
current options, printing worksheets,  176
custom equations,  295
Customize Quick Access Toolbar button,  198
Customize Ribbon page,  204
Customize The Ribbon button,  201
customizing Excel

choosing color to display errors,  207
controlling AutoFormat rules,  214
controlling which error messages 

appear,  210–211
defining AutoCorrect entries,  212–213
hiding/displaying ribbon tab,  208–209
Quick Access toolbar

adding commands to,  198–199
moving the toolbar,  200

ribbon elements
adding/reordering,  202–203
creating new ribbon tabs,  204–205
removing,  201
renaming,  206

workbook templates
ready-to-use,  194–195
saving a workbook as a 

template,  196–197
customizing file properties,  27
Custom Lists dialog box,  218
custom sort lists,  218–219
cutting cell values,  62

D
data

filtering
AutoFilter,  220–221
search filters,  222

graphic displays,  253

contents (cells), formatting,  122–124, 
136–137

contiguous groups of cells,  40
copying

cell values,  62
chart data into PowerPoint,  304–305
Excel data into Word,  303
formats (Format Painter),  150
web data to Excel,  326
worksheets,  77

COT function,  119
COTH function,  119
creating

advanced filters,  226–227
AutoCorrect entries,  212
change history (group 

environments),  318–319
charts,  240–241
charts, Recommended Charts gallery,  11
custom sort lists,  218–219
data subtotals,  110
Excel tables,  52–54
filtering rules,  221
formulas,  98–99

Excel table references,  103
named ranges,  102
referencing other workbooks,  104–106

hyperlinks,  58–61
IF functions,  114
multicolumn sorts,  217
named ranges,  100
recommended PivotTables,  14, 236–237
ribbon tabs,  204–205
selection filters,  220
stock charts,  260
summary formulas,  109
validation rules,  232–233
win/loss sparklines,  263
workbooks,  28
workbook themes,  156
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condition formats,  140–141
formulas,  98
object shadows,  276
workbooks

Excel Web App,  332–333
Excel Web Apps,  15

effects
creating text effects with 

WordArt,  284–285
drawing objects,  276–277

effects, formatting worksheets,  154–155
email, mailto hyperlinks,  61
embedding files,  298–301
embedding workbooks in 

webpages,  334–335
ENCODEURL function,  120
enhancing worksheets

graphics,  268
adding/deleting pictures,  270–271
clip art,  286–287
diagrams,  288–289
drawing objects,  269, 276–277, 282–283
removing image backgrounds,  280–281
reordering objects,  296
resizing/rotating objects and 

images,  278–279
shapes,  272–275, 294–295
SmartArt,  292–293

organization charts,  290–291
WordArt,  284–285

entering data.  See data entry
equations, adding to shapes,  294–295
Equation Tools Design tab,  294
error messages, controlling 

appearance,  210–211
errors

display color,  207
ignored,  211

Evaluate Formula dialog box,  116

Design tab, formatting sparklines,  264–265
desktop sharing,  337
diagrams,  288–289
dialog boxes

Allow Changes By More Than One 
User,  312

AutoCorrect,  214
Colors,  81
Custom Lists,  218
Evaluate Formula,  116
Excel Help,  98
Excel Options,  56, 204, 218
Find And Replace,  71
Format Cells,  51, 125
Function Arguments,  112
Insert Function,  112
List Changes On A New Sheet,  319
Number,  51
Open,  24
Refresh Every,  327
Track Changes While Editing,  315

displaying
data bars,  144
data, graphically,  253
errors (color selection),  207
icon sets,  145
Office Clipboard contents,  68
ribbon tab,  208–209
worksheets,  80

Documents folder,  34
drawing objects,  269

aligning and grouping,  282–283
effects,  276–277

E
editing

cell contents,  56
comments, group environments,  314

text,  42
validation rules,  232–234

data labels (charts),  248–249
Data Labels check box,  248
data rows,  52
data series (charts),  254–255

adding trendlines to,  261
Data Validation button,  232
dates

entering in cells,  44–45
formatting cells,  125

DAYS function,  118
debugging formulas,  116–117
DECIMAL function,  119
decimal values,  51
Decrease Decimal button,  127
default file folders, changing,  34
Default Local File Location box,  34
defining

custom properties,  27
filters,  229
filters, using slicers,  13

deleting
AutoCorrect entries,  213
cells,  83
cell styles,  134–135
columns,  86
comments, group environments,  314
condition formats,  140–141, 147
named ranges,  101
pictures from worksheets,  270–271
rows,  86
rows/columns in worksheets,  166
sparklines,  265
watches (Watch Window),  117
worksheets,  78–79

delimiters,  308
dependents (formula references),  115
descending order (sorting data),  216
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worksheets
coloring sheet tabs,  157
deleting rows/columns,  166
gridlines,  158–159
grouping/ungrouping rows,  167
hiding rows/columns,  168–170
inserting rows/columns,  162
locking cells,  172
moving rows/columns,  164–165
protecting worksheets from 

change,  171–172
resizing rows/columns,  161
row heights/column widths,  160
setting Insert Options,  163
themes,  152–156

Formula Auditing group,  115
Formula AutoComplete,  102
formula bar,  42

editing cell contents,  56
Insert Function button,  112

formulas
building,  98
creating,  98–99

Excel table references,  103
named ranges,  102
referencing other workbooks,  104–106

debugging,  116–117
dependents,  115
editing,  98
monitoring for changes,  116
named ranges,  102
precedents,  115
summary,  109

FORMULATEXT function,  119
fractions,  51
Function Arguments dialog box,  112
functions,  112–113

Excel 2013 list of,  118–120
IF,  114
ScreenTips,  113

clearing,  224–225
search,  222
selection,  220

FILTERXML function,  120
Find And Replace dialog box,  71
finding text,  70–71
Flash Fill,  10
Flash Fill, data entry,  48–49
FLOOR.MATH function,  119
fonts

formatting cell contents,  122
formatting text in  a shape,  272
formatting worksheets,  154–155

footers, printing worksheets,  186–189
forced line breaks, entering text,  42
foreground image,  280
Format Axis button,  251
Format Cells dialog box,  51, 125
Format Painter,  150
formatting

cells
backgrounds and shading,  128–129
borders,  130–131
color scales,  146
condition formats,  138–143
contents,  122–124, 136–137
data bars/icon sets,  144–145
dates,  125
defining cell style,  132–133
Format Painter,  150
merging/splitting cells,  148–149
modifying/deleting cell style,  134–135
numbers,  126–127

charts,  16
axes,  250–251
legends and titles,  246–247

multiple worksheets,  90–91
sparklines,  264
text in a shape,  272

Excel Help dialog box,  98
Excel Help system,  36

web resources,  37
Excel Options dialog box,  56, 204, 218
Excel tables

creating,  52–54
referencing in formulas,  103

Excel Web App, editing workbooks,  332–333
Excel Web Apps, editing workbooks,  15
existing workbooks, opening,  24–25
exiting Excel,  35
Expand Formula Bar control,  42
exponents,  43
Extensible Markup Language.  See XML 

(Extensible Markup Language)

F
file properties,  26–27
files

embedding,  298–301
linking,  298–301
saving to the cloud with SkyDrive,  329
Strict Open XML Spreadsheet,  330

fills
AutoFill,  46–47
Flash Fill,  48–49

fill shapes,  274–275
filtering

charts,  256–257
data

AutoFilter,  220–221
search filters,  222

tables,  228–229
filtering rules,  221
filtering tables, slicers,  12–13
filters

active,  225
advanced,  226–227
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ignored errors, resetting,  211
images

removing backgrounds,  280–281
rotating/resizing,  278–279
shapes,  274–275

IMCOSH function,  118
IMCOT function,  118
IMCSC function,  118
IMCSCH function,  118
importing

text files,  308–309
XML spreadsheet files,  331

IMSEC function,  118
IMSECH function,  118
IMSINH function,  118
IMTAN function,  118
Increase Decimal button,  127
Indicate Errors Using This Color button,  207
Insert Function button (formula bar),  112
Insert Function dialog box,  112
inserting

cells,  82
clip art into worksheets,  286–287
diagrams in worksheets,  288–289
rows/columns,  84
rows/columns in worksheets,  162
symbols in cells,  57
worksheets,  78–79

Insert Options menu, formatting 
worksheets,  163

insert options, setting,  85
interpretation of data,  51
Interval Between Marks box,  251
ISFORMULA function,  119
ISOWEEKNUM function,  118

retrieving web data,  324–326
saving data using SkyDrive,  329
saving worksheets to the web,  320–321
sharing workbooks on the web,  334–336
tracking changes in workbooks,  315
updating worksheets published to the 

web,  322–323
workbook sharing,  312
XML applications,  330–331

Group group (Design tab),  264
grouping, drawing objects,  282–283
grouping rows,  167
groups, ribbon tab,  204–205

H
header rows,  52
headers, printing worksheets,  177, 181, 

186–189
height (rows), formatting worksheets,  160
Help system,  36

web resources,  37
Hide Detail button,  170
hiding

chart grid lines,  249
chart legends,  246
ribbon tab,  208–209
rows/columns,  88–89
rows/columns in worksheets,  168–170
worksheets,  80

Highlight Changes button,  318
HTML (Hypertext Markup Language),  328
hyperlinks, creating,  58–61
Hypertext Markup Language (HTML),  328

I
icon sets, displaying,  145
IF function,  114
IFNA function,  119

G
galleries,  19
GAMMA function,  120
GAUSS function,  120
Get External Data button,  324
going to a named range,  100
grand totals (summarizing data),  110–111
graphic displays, data,  253
graphics,  268

adding/deleting pictures,  270–271
adding to headers and footers,  188–189
clip art,  286–287
diagrams,  288–289
drawing objects

aligning and grouping,  282–283
effects,  276–277

drawng objects,  269
removing image backgrounds,  280–281
reordering objects,  296
resizing/rotating objects and 

images,  278–279
shapes,  269, 272–275

adding equations,  294–295
SmartArt,  292–293

Gridline Color button,  158
gridlines

formatting worksheets,  158–159
printing worksheets,  177

grid lines (charts),  248–249
Group button,  283
group environments, sharing data

accepting/rejecting changes,  316–317
adding/viewing comments,  313
editing/deleting comments,  314
Excel Web App,  332–333
Lync,  337
maintianing a change history,  318–319
modifying web queries,  327
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noncontiguous rows/columns,  41
Number dialog box,  51
numbers

entering in cells,  43
formatting cells,  126–127

NUMBERVALUE function,  120

O
objects

embedding,  298–301
reordering,  296
rotating/resizing,  278–279

Office Clipboard,  68–69
Office Web Apps, editing workbooks,  15
Open dialog box,  24
opening workbooks,  24–25
organization charts,  290–291, 292–293
Orientation button,  137
orientation (page), printing 

worksheets,  184–185
orienting cell contents,  136–137
overview of Excel 2013,  2–5

P
page breaks, printing worksheets,  190–191
Page Layout view,  174
page orientation, printing 

worksheets,  184–185
paper options (printing worksheets),  179
pasting

Access data into worksheets,  306
cell values,  62, 64–65
text into Excel,  308–309
Word data into Excel,  302

Pattern Color down arrow,  129
Pattern Style down arrow,  129
PDURATION function,  119
Percent number style,  126

merging cells,  148–149
Microsoft Excel Web Apps, editing 

workbooks,  15
Middle Align button,  136
model equations,  294
modifying

cell styles,  134–135
web queries,  327

monitoring changes (formulas),  116
moving

cells,  83
Excel data to PowerPoint,  304
Quick Access toolbar,  200
rows/columns,  87
rows/columns in worksheets,  164–165
worksheets,  76

multicolumn sorts,  217
multiple worksheets

formatting,  90–91
selecting and viewing,  74

MUNIT function,  120

N
named ranges (cells),  100–101, 102
naming, worksheet views,  94
navigation, keyboard shortcuts,  67
negative exponents,  43
new features

filtering tables using slicers,  12–13
Flash Fill,  10
formatting charts,  16
functions,  118–120
Quick Analysis Lens,  9
Recommended Charts gallery,  11
recommended PivotTables,  14
SkyDrive,  15
using Excel 2013 in Windows 8,  8

noncontiguous groups of cells,  40

K
keyboard shortcuts, navigating 

worksheets,  67

L
landscape mode,  184
layout (charts),  242–243
layout (charts), formatting,  16
Legend check box,  246
legends, charts,  246–247
line breaks, entering text,  42
line sparklines,  262
linking files,  298–301
links (workbooks),  105–106
List Changes On A New Sheet dialog box,  319
locating workbooks, file properties,  26–27
Location Range box,  263
locking cells,  172
Lync Meetings,  337
Lync, sharing worksheets online,  337

M
mailto hyperlinks,  61
management

worksheets
changing tab color,  81
copying,  77
hiding/showing,  80
inserting/deleting,  78–79
moving,  76
renaming,  75
viewing and selecting,  74

manipulating pie charts,  258–259
manual page breaks,  191
margins, printing worksheets,  182–183
Match Destination Formatting icon,  306
Merge & Center button,  148
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renaming
Excel tables,  54
named ranges,  101
ribbon elements,  206
worksheets,  75

reordering
objects,  296
ribbon elements,  202–203

replacing text,  70–71
Reset Ignored Errors button,  211
resizing

Excel tables,  55
objects,  278–279
windows,  30

resizing rows/columns,  161
retrieving web data,  324–326
ribbon elements

adding/reordering,  202–203
creating new ribbon tabs,  204–205
removing,  201
renaming,  206

ribbon tabs
creating,  204–205
hiding/displaying,  208–209

ribbon user interface,  18–19
rotating objects,  277, 278–279
rows

data,  52
deleting,  86
formatting worksheets

changing height,  160
deleting,  166
grouping/ungrouping,  167
hiding,  168–170
inserting,  162
moving,  164–165
resizing,  161

header,  52
headings, printing worksheets,  181

Q
Quick Access toolbar

adding commands to,  198–199
moving,  200
Undo/Redo buttons,  63

Quick Analysis lens,  107
Quick Analysis Lens,  9
Quick Layout button,  242

R
ready-to-use templates,  194–195
Recent Workbooks list,  24
recommended charts,  241
Recommended Charts button,  241
Recommended Charts gallery,  11, 240
recommended PivotTables,  14, 236–237
Redo button,  63
references

referencing tables in formulas,  103
referencing workbooks in 

formulas,  104–106
Refresh Every dialog box,  327
refreshing links (workbooks),  105
regional settings, influence on Excel 

interpretation of dates,  44
rejecting changes in group 

environments,  316–317
relative references,  99
removing

chart filters,  257
commands from Quick Access toolbar,  199
data labels from charts,  248
data series,  255
image backgrounds,  280–281
ribbon elements,  201
slicers,  231
subtotals,  111
tracer arrows,  115

Percent Style button,  126
PERMUTATIONA function,  120
PHI function,  120
photographs, adding to worksheets,  270–271
Pie Chart button,  259
pie charts,  258–259
pinning Excel 2013 to taskbar,  21
pivoting PivotTables,  237
PivotTables,  14, 236–237
portrait mode,  184
positive exponents,  43
PowerPivot,  223
PowerPoint, sharing data with Excel,  304–305
PowerView,  235
precedents (formula references),  115
predefined headers/footers,  186–187
predefined text,  186–187
previewing worksheets before 

printing,  174–175
print area (printing part of a worksheet),  180
printer selection (printing worksheets),  178
printing worksheets

current options,  176
gridlines and headings,  177
headers and footers,  186–189
page breaks,  190–191
page orientation and scale,  184–185
paper options,  179
preview,  174–175
printer selection,  178
row and column headings,  181
setting margins,  182–183
setting print area,  180

program window,  18–19
Properties fields,  26
properties (file properties),  26–27
protecting worksheets from change,  171–172
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Show Detail button,  170
Show Error Alert After Invalid Data Is Entered 

check box,  233
Show group (Design tab),  264
showing

chart grid lines,  249
chart legends,  246
worksheets,  80

Show Input Message When Cell Is Selected 
check box,  233

Silverlight,  235
size (fonts), formatting cell contents,  122
sizing windows,  30
SKEW.P function,  120
SkyDrive,  15
SkyDrive, saving data to the cloud,  329
slicers

clearing,  230
filtering tables,  228–229
removing,  231

slicers, filtering tables,  12–13
slices (pie charts),  258
SmartArt graphics,  292–293
SO.CEILING function,  120
Sort Ascending button,  216
Sort Descending button,  216
sorting data,  216–219
source data (charts),  252
Sparkline group (Design tab),  264
sparklines,  262–265
special paste options,  64–65
spelling checker,  72
splitting cells,  148–149
splitting worksheets,  92
spreadsheet files (XML), importing,  331
starting Excel,  20–21

Windows 7,  23
Start screen,  20–21

Windows 8,  22

shading (formatting cells),  128–129
Shape Effects button,  276
shapes

adding equations,  294–295
adding text to,  272
adding to worksheets,  269
fill color,  274–275
images,  274–275
style,  273

Shapes button,  269
Shape Styles group,  245, 273
sharing data

Excel and Access,  306–307
Excel and PowerPoint,  304–305
Excel and Word,  302–303
group environments

accepting/rejecting changes,  316–317
adding/viewing comments,  313
editing/deleting comments,  314
Excel Web App,  332–333
Lync,  337
maintianing a change history,  318–319
modifying web queries,  327
retrieving web data,  324–326
saving data using SkyDrive,  329
saving worksheets to the web,  320–321
sharing workbooks on the web,  334–336
tracking changes in workbooks,  315
updating worksheets published to the 

web,  322–323
workbook sharing,  312
XML applications,  330–331

importing text files,  308–309
linking and embedding files,  298–301

SHEET function,  119
SHEETS function,  119
sheet tabs (formatting worksheets),  157
shortcuts

data entry,  50–51
navigating worksheets,  67

hiding/unhiding,  88–89
inserting,  84
moving,  87
selection,  41

RRI function,  119

S
Save button,  32
saving

data using SkyDrive,  329
workbooks,  32–33
workbooks as Strict Open XML 

Spreadsheet files,  330
workbooks as templates,  196–197
worksheets to the web,  320–321

scale
printing worksheets,  184–185

Scale To Fit group,  185
scientific notation,  43
ScreenTips (functions),  113
Search button,  37
search filters,  222
searching for workbooks,  38
SEC function,  120
SECH function,  120
selection

cells,  40–41
columns,  41
rows,  41
worksheets,  74

selection filters,  220
sending Excel data to Access,  307
separating data, Flash Fill,  10

,  49
series of values, AutoFill,  47
Series Values box,  254
setting

file properties,  26
insert options,  85
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tracking changes, workbooks,  315
trademarks, inserting symbols in cells,  57
trendlines (charts),  261
Tufte, Edward,  262
Type group (Design tab),  264

U
Undo button,  63
ungrouping rows,  167
unhiding rows/columns,  88–89
UNICHAR function,  120
UNICODE function,  120
user interface,  18–19

V
validation rules,  232–234
viewing

comments, group environments,  313
workbooks,  92–93
worksheets,  74, 92–93

viewing windows,  30
views, worksheets,  94–95

W
Watch Window,  116, 117
web data, retrieving,  324–326
webpages

embedding workbooks in,  334–335
saving worksheets to the web,  320–321
updating worksheets published to the 

web,  322–323
web queries

modifying,  327
retrieving web data,  324–326

web resources, Help system,  37
WEBSERVICE function,  120
width (columns), formatting worksheets,  160

T
tab colors (worksheets),  81
tables

creating,  52–54
exchanging data between Excel and 

Word,  302–303
filtering,  228–229
filtering with slicers,  12–13
referencing in formulas,  103

templates,  196–197
text

adding to shapes,  272
creating effects with WordArt,  284–285
entering in cells,  42
finding and replacing,  70–71

Text button,  137
text files, importing,  308–309
themes

formatting worksheets,  152–156
applying a theme to a 

workbook,  152–153
creating new themes,  156
fonts and effects,  154–155

Tick Marks button,  251
times, entering in cells,  44–45
titles, charts,  246–247
toolbars

Quick Access
adding commands to,  198–199
moving,  200
Undo/Redo buttons,  63

tools, Quick Analysis Lens,  9
Top Align button,  136
touchscreen adaptations,  5
tracer arrows,  115
tracing precedents/dependents,  115
Track Changes,  315
Track Changes While Editing dialog box,  315

Start screen, Windows 8,  8
stock charts,  260
Strict Open XML Spreadsheet files,  330
style

charts,  242–243
formatting cells,  132–135
formatting charts,  16
shapes,  273

Style group (Design tab),  264
styles gallery,  19
subtotals (summarizing data),  110–111
summarizing data

charts,  240–241
appearance,  244–245
data labels and grid lines,  248–249
data series,  254–255
filtering,  256–257
formatting chart axes,  250–251
layout and style,  242–243
legends and titles,  246–247
pie charts,  258–259
source data,  252
sparklines,  262–265
stock charts,  260
trendlines,  261

groups of cells,  108
Quick Analysis lens,  107
recommended PivotTables,  14
subtotals and grand totals,  110–111
summary formulas,  109

summary formulas,  109
switching between workbooks,  29
Switch Windows button,  29
symbols, inserting in cells,  57
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formatting multiple sheets at one 
time,  90–91

graphics,  268
adding/deleting pictures,  270–271
clip art,  286–287
diagrams,  288–289
drawing objects,  269, 276–277, 282–283
removing image backgrounds,  280–281
reordering objects,  296
resizing/rotating objects and 

images,  278–279
shapes,  272–275, 294–295
SmartArt,  292–293

hiding,  80
hiding/unhiding rows/columns,  88–89
hyperlinks,  58–61
inserting,  78–79
inserting cells,  82
inserting rows/columns,  84
linking and embedding files,  298–301
moving,  76
moving cells,  83
moving rows/columns,  87
navigation keyboard shortcuts,  67
organization charts,  290–291
printing

current options,  176
gridlines and headings,  177
headers and footers,  186–189
page breaks,  190–191
page orientation and scale,  184–185
paper options,  179
preview,  174–175
printer selection,  178
row and column headings,  181
setting margins,  182–183
setting print area,  180

renaming,  75
saving to the web,  320–321

precedents and dependents,  115
referencing Excel tables,  103
referencing other workbooks,  104–106

data entry
AutoFill,  46–47
cell selection,  40–41
clearing cell contents,  66–67
creating Excel tables,  52–54
cutting, copying, and pasting cell 

values,  62, 64–65
dates and times,  44–45
editing cell contents,  56
finding/replacing text,  70–71
Flash Fill,  48–49
galleries,  19
inserting symbols in cells,  57
numbers,  43
Office Clipboard,  68–69
shortcuts,  50–51
spelling checker,  72
text,  42

deleting,  78–79
deleting cells,  83
deleting rows/columns,  86
formatting

coloring sheet tabs,  157
deleting rows/columns,  166
gridlines,  158–159
grouping/ungrouping rows,  167
hiding rows/columns,  168–170
inserting rows/columns,  162
locking cells,  172
moving rows/columns,  164–165
protecting worksheets from 

change,  171–172
resizing rows/columns,  161
row heights/column widths,  160
setting Insert Options,  163
themes,  152–156

Windows 7, starting Excel,  23
Windows 8

starting Excel,  20–21
Start screen,  22

Windows 8, Start screen,  8
windows, sizing and viewing,  30
win/loss sparklines,  262–263
WordArt,  284–285
Word, sharing data with,  302–303
workbooks.  See also worksheets

closing,  35
copying worksheets,  77
creating,  28
editing

Excel Web App,  15, 332–333
embedding in webpages,  334–335
identifying in XML,  328
links,  105–106
locating by using file properties,  26–27
moving worksheets within and among,  76
opening,  24–25
referencing in formulas,  104–106
saving,  32–33
saving as Strict Open XML Spreadsheet 

files,  330
searching,  38
sharing,  312, 334–336
sizing and viewing windows,  30
switching between workbooks,  29
templates

ready-to-use,  194–195
saving workbook as a template,  196–197

tracking changes,  315
viewing,  92–93

worksheets.  See also workbooks
changing tab colors,  81
copying,  77
creating cell formulas,  98–99

named ranges,  100–102
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selecting,  74
setting insert options,  85
sharing online using Lync,  337
showing,  80
sorting data,  216–219
undoing/redoing an action,  63
updating those published to the 

web,  322–323
viewing,  74, 92–93
views,  94–95
WordArt,  284–285
zooming in and out,  31

X
XML (Extensible Markup Language)

identifying Excel workbooks,  328
importing spreadsheet files,  331
Strict Open XML Spreadsheet files,  330

XOR function,  119

Z
Zoom In control,  31
zooming in and out (worksheets),  31
Zoom Out control,  31
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of this book? 
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To participate in a brief online survey, please visit: 
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